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Style conventions used in this document: 

 

UI Text:  Text that represents elemets of the UI such as button names, menu 
options etc is presented with a grey background and border, in 
Tahoma font which is traditionally used in Windows UIs. For example:  

  Ok  

 

Standard Terms (Jargon): Text that is not English Language but instead refers to 
industry standard concepts such s Strategy, BACnet, or Analog Input 
is represents in slightly condensed font. For example:  

BACnet 

 

Code:  Text that represents File paths, Code snippets or text file 
configuration settings is presented in fixed-width font, with a grey 
background and border. For example: 

$config_file = c:\CYLON\settings\config.txt 

 

Parameter values: Text that represents values to be entered into UI fields, or 
displayed in dialogs is represented in fixed-width font with a shaded 
background. For example  

10°C 

 

Product Names: Text that represents a product name is represented in bold 
coloured text. For example 

CBX-8R8-H 

 

PC Keyboard keys: Text representing an instruction to press a particular key on 
the keyboard is enclosed in square brackets and in bold folt. For 
example: 

[Ctrl]+[1] 
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WHAT IS THE CXproHD SITE BACKUP UTILITY? 

The CXpro
HD

 Site Backup Utility (sometimes referred to as Backup) is a module of the Cylon software suite.  

The Cylon system consists of hardware controllers linked together to form a ‘Site’, and software on a 
Supervisory PC. The Cylon software on the PC supervising the Cylon hardware uses data files, which are 
organised on the PC in a directory structure representing the structure of the Site. 

Backup allows this directory structure, and any other relevant files to be archived, so that it can be installed on 
another PC, or restored to the original PC. 

The main uses of the Site Backup Utility are: 

COPYING A SITE TO ANOTHER PC  

For instance, if an engineer needs to visit a site, and needs to transfer site files (perhaps from the office PC to 
a laptop, or from a laptop to a site’s supervisory PC) the files required for the site can be copied between PCs 
using this utility. 

SYNCHRONISING MODIFICATIONS TO A SITE  

Several people may be working on different parts of a site, using separate PCs to modify strategies, globals and 
drawings. It is necessary at some time to compile all the changes into one copy of the site, on the site’s 
supervisory PC. Using the Site Backup Utility it is possible to transfer only the modified files from each PC, and 
so synchronize all the changes on the main PC. 

 MAKING A SECURITY COPY OF THE SITE 

For security in case of damage to a supervisory PC, or its files, it is usually a good idea to keep a backup of the 
full site, which can be restored to the original PC, or replacement PC if required. 

 

 



 
 

 

SECTION 2 :  USING THE SITE 
BACKUP UTILITY 
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When the CXpro
HD

 Site Backup Utility (Backup) is started, the Backup Interface (see page 26) is displayed. From 
the Menus and Toolbar Icons in the interface, all of the options in the Site Backup Utility can be accessed. 

These options include: 

 Backing up a site (see page 10)  

 Restoring a site (see page 16) 

 Viewing the contents of an existing backup (see page  19) 

 Changing the current default site (see page 9) 

Note:  CXpro
HD

 does not need to be running when you use the Site Backup Utility. However, CXpro
HD

 
must be installed on the PC, otherwise there would be no site structure for the Site Backup 
Utility to operate in. 
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STARTING BACKUP 

To start Backup, select its icon from the Utilites  group in the Home  tab of the Cxpro
HD

 Ribbon : 

 

This opens the Backup window. 
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BACKING UP A SITE 

 ‘Backing Up’ a site means copying some or all of the files associated with the site into a compressed Backup 
(“.csb”) file. The compressed file can either be stored, so that the site can be repaired if it becomes damaged 
on the original PC, or transferred to another PC, so that a duplicate of the site can be made. This can be used 
to set up a portable PC for a site visit, or to synchronize modifications made to a site on several PCs.  

It is possible to back up a complete site, or parts of a site. For this reason, before a site can be backed up, it 
must first be prepared for backup i.e. you must set the Backup options, and select the files and directories to 
be backed up. 

To back up a site, follow these steps: 

 Set the Backup options  

 Select the Directories and Files to be backed up 

 Run the Backup. 

 

Setting the required Backup options 

It is possible to change the criteria that the Backup utility will use when preparing a site for backup (i.e. 
selecting the files to be included in the .csb file). 

You can either: 

 Select the required items 

from the Backup Options  

menu. 

  

or, 

 From the toolbar select 

the fifth button Select  

backup/restore options  

 

then from the displayed Select Backup/Restore Options  dialog box select/deselect the required items. For details 

about the backup options, and how to use them, see Backup Options on page 15. 
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Selecting the Files to be Backed Up 

In order to create a backup of a site, you must first select the files to be included in the .csb file. This is 

known as ’preparing a site for backup’. The files are automatically selected based on the Backup Options  (see 

The Options dialog box on page 34), but you can manually add or remove directories and files from the backup 
set. 

To select the files and directories:  

First select the site to be backed up by clicking on it in the Site List tab of Backup’s Details window: 

 

Next, put the program in Preparation mode using one of the following methods: 

 From the File  Menu, select the 

Prepare for Backup  menu item: 

  

 From the toolbar select the second button Prepare Site  

for backup : 

  

 Press [Ctrl] + [F] simultaneously on the keyboard  
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Note:  If you select the Prepare for backup  function without first selecting a site, the following message 

will appear: 

  

 When you press the   button, the program will return to its previous state. 

 If a site is selected, a confirmation box will appear: 

  

 

Note: The site contained in the message box will be the one selected from the site list and not 
necessarily “Office Block” as shown in the example above. 

If you press the No  button, the program will return back to its previous state. 

If you press the Yes  button, the Details Window will change to the Selected files  tab. 

The directories and files required to back up the selected site will appear in the two list boxes: 

  

Once a site is displayed in the  Selected Files  tab, you can remove individual directory(s) or file(s) from the 

backup (see Details Window - Selected Files tab on page 32. 

When the Selected Files tab displays all the directories and files to be backed up, you can proceed with 
running the Backup operation. 
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Running a Site Backup 

Once a site has been prepared for a backup, by setting the options (see page 10) and files (see page 11) to be 
archived, the backup can be carried out. 

To start the backup, using one of the following methods: 

 From the File  menu 

select Backup , 

  
 From the toolbar select 

the first button, Backup  

site  
  

 Press [Ctrl] + [B] simultaneously on the keyboard  

Note:  If you select one of the above options, and no site has been prepared for backup, the warning 
“You must prepare a site” will appear. 

When any of the above options is selected, and a site has been properly prepared, the following message box 
will be displayed: 

  

Note: The site contained in the message box will be the one selected from the sites list and not 
necessarily “Office Block” as shown in the example above. 

If you press the No  button, the program will return back to its previous state. 

If you press the Yes  button, the  Select File  dialogue box will open: 
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The File name  text box will contain the current site description, which can be changed to any legitimate 

Windows file name. You can also change the destination to which the backup will be saved. 

If you press the Cancel  button, the program will return back to its previous state. 

If you press the Save  button, the program will create the required backup. During the backup process the 

program will continually update the status bar at the bottom of the window with the current file being 
processed and will update the progress bar at the top of the window as necessary  

 

Note:  The backup process can be cancelled at any time by selecting the fourth button on the toolbar 
“Cancel current operation” 

  

When the backup has been successfully completed, the following message will be displayed: 

 

Press OK  to return to the Backup Interface. 

If a site is not prepared... 
If you try to run a backup without setting up properly, the following dialog will be displayed: 

  
If you select Yes , the program will go into the Prepare Site for Backup procedure, so that you can select files 

for backup (see page 11). 
You must also set the correct backup options (see page 10). 
When the site is prepared, you can return to running the backup (see page 13). 
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BACKUP OPTIONS 

Each of the options below can be selected from the Backup Options  menu, 

 

or the Select Backup/Restore Options  dialog box: 

  

Exclude *.BAK files 

Some programs, such as CCView can generate files, which are duplicates of other files, with the extension 
.BAK. These act as a ‘safety measure’ in case something goes wrong with the main file. They are not necessary 
to the operation of the site and so can be excluded from the site’s backup in order to make the .csb file 
smaller, and save disk space. 

When this item is selected then during a prepare for backup the program will check each file that it is adding 

to the File(s)  list box to see if its file extension is .BAK, if it is then the program will not include the file in the 

File(s)  list box. 

Exclude *.CSV files 

A site may contain .CSV files, which are archives storing historical data from datalogs in the site. This 
information is not required for the operation of the site, and so can be excluded from the backup in order to 
reduce the size of the .csb file, and save disk space. 

When this item is selected then during a prepare for backup the program will check each file that it is adding 
to the “File(s)” list box to see if its file extension is “.CSV”, if it is then the program will not include the file in 
the “File(s)” list box. 
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RESTORING A SITE 

‘Restoring” a site means copying files from a Backup compressed (.csb) file onto a PC to create or adjust a 
Cylon  site. This can be carried out: 

 on the PC that created the .csb file originally, to repair a damaged site, or  

 on another PC, to create a duplicate site. This can be used to set up a portable PC for a site visit, 
or to synchronise modifications made to a site on several PCs. 

A Site Restore operation can be carried out with different options, for instance overwriting existing files, or 
rebooting the computer on completion, so before running a Site Restore operation, you must set the restore 
options. 

Also, before a Site Restore operation, you can view the contents of an existing backup (.csb) file, to check if 
it’s the one you want to restore (see page 19). 

When the restore options are set, and you have selected the correct .csb file, you can run a Restore site 
operation. 

 

Setting the required restore options 

It is possible to select certain criteria that the program will use when restoring a site from a backup. There are 
two methods of selecting the required restore options: 

 From the Restore Options  menu 

select the required menu 
item(s) 

  

or, 

 From the toolbar select the fifth 

button Select backup/restore options    

then from the displayed Options dialog box select/deselect the required items. For details see Restore Options 
on page 19. 
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Running a Site Restore operation 

To start to Restore a site, use one of the following methods 

 From the File  menu select Restore , 

 From the toolbar select the third button, Restore site     

 
 

 Press [Ctrl] + [R] simultaneously on the keyboard 

If any of the above options is selected, the Select files to Restore  dialog will appear: 

  

The dialogue box will list any current Backup type (.csb) files in the selected directory. If the file you wish to 

restore is an older Backup type or a Backsite type then these can be selected from the Files of type  drop down 

list box. 

You can change the source directory listed in the dialog box by selecting from the Look in  box, or by clicking 

on listed directories.  

Select a file or enter the name of the file in the File name  box. 

If you press the Cancel  button, the program will return back to its previous state. 

If you press the Open  button, the program will read the selected backup and the following message box will 

appear: 

  

Note: The Site contained in the message box will be the one contained within the selected backup,  
and not necessarily the one shown above. 

 If you press the No  button, the program will return back to its previous state. 

 If you press the Yes  button, the program will restore the selected backup.  
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Note: If the .csb extension has been associated with the Site Backup Utility in the Windows operating 
system (see Associate File Extension on page 27), then when a file with a .csb extension is 
selected in Windows Explorer, Backup will run and automatically start the restore operation for 
the selected file. 

During the restore process the program will continually update the status bar at the bottom of the window 
with the current file being processed and will update the progress bar at the top of the window to show how 
much of the process is complete. 

  

Note:  The backup process can be cancelled at any time by selecting the fourth button on the toolbar 

Cancel current operation . 

  

 

Note: If a restore is cancelled during its operation, then you should not use the site that was being 
restored. Some necessary files may be missing, leading to unpredictable results. If you need to 
work on the site, first re-run the restore operation, and allow it to finish without cancellation.  
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RESTORE OPTIONS 

Each of the options below can be selected from the Restore Options  menu, 

 

or the Select Backup/Restore Options  dialog box: 

  

Confirm file overwrite 

When this item is selected then during a restore if a file currently exists on the hard disk of the machine the 
program ask if this file is to be overwritten. 

Overwrite WN3000 units section 

When this item is selected then after a restore the program will copy the contents of the UNITS.INI file 
contained within the restored projects sub-directory to the WN3000.INI file in the UnitronUC32 System 
directory, overwriting items where necessary. 
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CHANGING THE CURRENT DEFAULT SITE 

The “Default Site” is the site to which CXpro
HD

 will connect when it is started. Usually, to change the site that 
CXpro

HD
 will use as its default, you must start the software, change the default in the Configuration Utility, and 

then close the software and re-start it.  

The Site Backup Utility has a facility to change the default Site for CXpro
HD

, whether or not the software is 
running. 

To do this, right-click on the required site in the Site Backup Utility’s Site List  tab. 

  

The following message box will appear 

  

Note:  The site contained in the message box will be the one selected and not necessarily the one 
shown above 

If you press No  the program will continue with the current operation. 

If you press Yes  the program will make the selected site the current site, and will ask one of the following 

questions, depending on whether the Cylon software is currently running: 
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If Cylon software is currently running 

 

 If you press No the program will continue with the current operation. 

 If you press Yes  the program will restart Windows and then close. 

 

If Cylon software is not currently running 

  

 If you press No  the program will continue with the current operation. 

 If you press Yes  the program will start the Cylon software and then close. 

Note:  If the current site is changed when the Cylon software is currently running and Windows is not 
restarted then unpredictable results within the Cylon software may result. 
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SAVING THE OPTION SETTINGS 

If the  Save Option Settings on Exit  option is set, the Backup/Restore Options  settings will be stored when the 

program is closed. When the program is next opened, the settings will be automatically retrieved. 

Each of the options below can be selected from the Backup Options  menu, 

 

or the Select Backup/Restore Options  dialog box: 
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VIEWING THE CONTENTS OF AN EXISTING BACKUP 

The contents of a backup can be viewed by selecting the View CCB Contents  menu item from the Restore  

menu. 

  

The Select file to restore from  dialogue box will appear: 

  

Select the file you want to view from the list of files. The name will appear in the File Name  text box. 

Note:  The contents of an older Backup type or a Backsite-type backup can not be viewed. 

If you press the Cancel  button, the program will return back to its previous state. 

If you press the Open  button, the details window will change to the CCB Contents  tab and the files 

contained within the backup the selected site will appear in the list box: 

 
 
 





 
 

 

SECTION 3 :  THE SITE BACKUP 
UTILITY INTERFACE 
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The Site Backup Utility interface displays Menus, Toolbar Icons, and windows from which all of the Site Backup 
Utility’s functions can be accessed. 

   

THE MENU BAR 

  

The Menu Bar , at the top of the Site Backup Utility interface, contains menus that give access to all Backup’s 

functions. To open a menu, click on its name in the menu bar. 

File menu 

The file menu contains options that send information from and to files 

 

Backup  

 Selecting this option from the File Menu starts the Backup operation (see page 10). 

It is the equivalent of the Backup  button on the toolbar, or pressing [Ctrl] + [B] on the PC’s keyboard. 

Prepare for Backup  

Selecting this option from the File Menu starts the Select files for backup operation (see page 11). 

It is the equivalent of the Prepare for Backup  Button on the toolbar, or pressing [Ctrl] + [F] on the PC’s keyboard. 

 

Restore  
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 Selecting this option from the File  Menu starts the Restore operation (see page 16). 

It is the equivalent of the Restore  button on the toolbar, or pressing [Ctrl] + [R] on the PC’s keyboard. 

Remember Size on Exit  

When this option is ticked on the File  menu, the position of the Site Backup Utility on the PC screen will be 

stored when the program closes. When the program is next opened, it will appear in the same place on the 
screen as it was when the program was closed. 

Save Option Settings on Exit  

If this option is ticked on the File  menu, the Backup Options settings will be stored when the program is closed. 

When the program is next opened, the settings will be automatically set. 

 

Exit  

 Selecting this option from the File  menu closes the Site Backup Utility. 

Associate File Extension  

 Selecting this option allows you to make an ‘association’ on your PC between the .csb filename extension and 
the Site Backup Utility. This means your PC will recognize that .csb files are to be opened with the Site Backup 
Utility. 

When you select the Associate File Extension  option from the File  menu, the following message appears: 

  

If you press No , the program will return to its previous state. 

If you press Yes , the Windows registry will be changed to associate .csb with the Site Backup Utility. 

When the association is made, the following message appears: 

  

Press OK  to return to the Site Backup Utility Interface. 
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Backup Options menu 

  

The Backup Options  menu allows you to enable or disable different options affecting the Backup operation. 

If an option has a tick beside it in the menu, it is enabled for the next backup operation. If there is no tick, the 
option is disabled. 

For more information about the individual options, see Backup Options on page 15. 

Restore Options menu 

  

The Restore Options  menu allows you to enable or disable different options affecting the Restore operation. 

If an option has a tick beside it in the menu, it is enabled for the next backup operation. If there is no tick, the 
option is disabled. 

For more information about the individual options, see Restore Options on page 19. 

  



 

 
 

MAN0137 rev 2 © Cylon Auto-Matrix 29 

 

Help menu 
 

The Help menu offers several sources of information about the Site Backup Utility and Cylon Controls. 

 

Site Backup Utility User Guide 

  

This opens the on-line manual for the Site Backup Utility 

 

Cylon Controls Home page 

  

Clicking on this causes the PCs default browser to open, and to load the Cylon Controls web page, from 
www.cylon-controls.com (which redirects to www.cylon.com). 

 

About the Site Backup Utility 

  

This opens a box displaying information about the current version of the Site Backup Utility: 

  

Press OK  to return to the Site Backup Utility Interface. 
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THE TOOLBAR 

  
The Toolbar , located just below the Menu bar  on the Site Backup Utility interface, contains buttons that act as 

short cuts to the most common features of the Site Backup Utility. 

Backup Site button 

  
Pressing this button on the Toolbar  starts the Backup operation (see page 10). 

It is the equivalent of the Backup  option on the File menu, or pressing [Ctrl] + [B] on the PC’s keyboard. 

Prepare Site for Backup button 

  
Pressing this button on the Toolbar  starts the Select files for backup operation (see page 11). 

It is the equivalent of the Prepare for Backup  option on the File menu, or pressing [Ctrl] + [F] on the PC’s keyboard. 

Restore Site button 

  
Pressing this button on the Toolbar  starts the Restore operation  (see page 16). 

It is the equivalent of the Restore  option on the File menu, or pressing [Ctrl] + [R] on the PC’s keyboard. 

Cancel Current Operation button 

 
 This toolbar button allows you to cancel the current operation in the Site Backup Utility. 
If you select cancel, the following 
message will appear:  
  

  
If you press No , the program will continue with the current operation. 

If you press Yes , the current operation will be cancelled and the program will return to its previous state. 

Select Backup options button 

  
Pressing this button on the toolbar opens the Select Backup/Restore Options  dialog box. 

Select Help button 

  
Pressing this button on the toolbar opens the About Backup  box. 
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THE DETAILS WINDOW 

  

The Details Window is the lower part of the Site Backup Utility interface. It displays information about the files 
that make up a site, and are to be backed up or restored. 

Tabs along the top of the Details window represent the different types of information available about files and sites. 

Details Window - Site List tab 

  

The  Site List  tab shows all the sites installed on the PC. To back up a site, or view details about a site, it must be 

selected in this window. 

Details Window - Site Details tab 

  

The Site Details  tab shows detailed information about the site selected in the Site List  tab. 

This information helps ensure that the correct Site has been selected for backup. 
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Details Window - Selected Files tab 

  

The Selected Files tab shows the directories and files that make up the site that has been prepared for backup. 

The directories are listed in the top part of the window, the files are listed in the lower part. 

How to remove a directory from the Select Files tab 

To remove a directory from the backup select the required directory then press the right mouse button.  

The Confirm  dialog will appear: 

 
  If you press the No  button, the program will return back to its previous state. 

 If you press the Yes  button, the selected directory(s) will be removed from the Directory(s)  list box 

along with any associated sub-directories and any associated files will be removed from the File(s)  list 

box. 

Note:  It is possible to select multiple directories using the [Shift] and [Ctrl] keys on the PC’s keyboard. 

How to remove a File from the Select Files tab 

To remove a file from the backup select the required file then press the right mouse button.  

The Confirm  dialog will appear: 

 

The Confirm Delete Files box will appear: 

 If you press the No  button, the program will return back to its previous state. 

 If you press the Yes  button, the selected files will be removed from the “File(s)” list box. 

Note:  It is possible to select multiple files using the [Shift] and [Ctrl] keys on the PC’s keyboard.  
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Details Window - Explorer tab 

  

The Explorer  tab allows you to examine the details of any site installed on the PC without selecting it for backup. 

The details shown are the same as those shown in the Site Details  tab for the site selected in the Site List  tab, 

but can be displayed for any or all sites. 

This tab allows you to browse through the installed sites, and is useful to compare different sites, or to identify a 
site for backup, etc. 

Details Window - CCB Contents 

  

The CCB Contents tab is used to list the files that are stored in the file created by a previous backup. 

To choose the files to display, select View CCB contents  from the Restore Options  menu. 
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THE OPTIONS DIALOG BOX 

The options that govern the Backup and Restore processes may be set either from the individual Backup Options  

and Restore Options  menus, or from the Select Backup/Restore Options  dialog box: 

  

This dialog opens when you press the  Options  button on the 

toolbar: 
 

You can select an option by placing a tick in the check box beside it. To de-select an option, clear the checkbox 
beside it. 

Descriptions of the different options are given in Backup Options on page 15 and Restore Options on page 19. 

If you press the Cancel  button, the dialog box will close and program will return to its previous state. 

If you press the Restore Defaults  button, the check boxes will be changed back to their default condition, the 

dialog box will close and program will return to its previous state. 

If you press the OK  button, the new setting will be used when a site is prepared for a backup. 

Note: The chosen settings will not be remembered the next time the program is run unless the ave  

settings on exit  menu option is selected form the File  menu  
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